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WAS IST MITEL WEB EXTENSION?
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Mitel Web Extension Online-Hilfe

Willkommen bei Mitel Web Extension! Die folgenden Artikel enthalten eine kurze Beschreibung der Mitel
Web Extension, die Installation der Mitel Web Extension in lhrem Browser, das Tatigen von Anrufen mit
der Mitel Web Extension, die unterstiitzten Telefonnummernformate und das Beheben haufiger Leistung-
sprobleme mit Mitel Web Extension

»  Was ist Mitel Web Extension?

e Voraussetzungen

» Systemvoraussetzungen

» Unterstiitzte Telefonnummern

» Installieren der Mitel Web Extension

» Verwenden der Mitel Web Extension

* Deinstallation der Mitel Web Extension

» Fehlerbehebung bei Problemen mit Mitel Web Extension

Was ist Mitel Web Extension?

M
Mitel Web Extension ( [ Mitel ) ist eine Browser-Extension, die Telefonnummern in der Microsoft
Teams-Webanwendung und in der Microsoft Outlook-Webanwendung erkennt und in anklickbare Tele-
fonlinks konvertiert. Nachdem Sie diese Extension in Ihrem Browser installiert haben, kdnnen Sie diese
Nummern mit allen unterstitzten Mitel-Telefonieanwendungen anrufen. Mit dieser Extension kénnen Sie
die Telefonnummer lhrer Kontakte oder eine andere in den Chat-Nachrichten angegebene Telefon-
nummer anrufen.

NOTE: Mitel Web Extension ist nur im Google Chrome Web Store verflgbar.

Voraussetzungen

1. Mitel empfiehlt, dass Sie jede unterstitzte Mitel-Telefonieanwendung (z. B. MiCollab) als Standarda-
nrufanwendung auf lhrem Gerét festlegen. Die Option zum Andern der Standard-App fiir Anrufe ist
spezifisch fur das Betriebssystem, unter dem Sie die Extension bereitgestellt haben. Klicken Sie auf
die folgenden Links, um Anweisungen zum Andern der fir lhr Betriebssystem spezifischen Standar-
danruf-App zu erhalten.

— Windows

- Mac OS

2. Wenn die unterstutzte Mitel-Anwendung auf Ihrem Gerat MiCollab ist, stellen Sie sicher, dass Sie
MiCollab 9.0 oder héher mit aktiviertem Softphone haben.

NOTE: Die Unterstlitzung fir MiVoice Office Mobile Application und Mitel Connect Client wird in
zuklnftigen Versionen hinzugefigt.



https://support.microsoft.com/en-in/help/4028161/windows-10-change-default-programs
https://support.apple.com/en-in/guide/facetime/fctm35545/mac
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Systemvoraussetzungen

Im Folgenden sind die Mindestsystemvoraussetzungen flr die Bereitstellung von Mitel Web Extension
aufgefihrt.

Unterstitztes Betriebssystem

Betriebssystem Version

Windows 10
macOS ab Version 10,14

Unterstutzter Browser

Browser Version

ab Version 84
ab Version 84

Google Chrome

Microsoft Edge

Unterstutzte Telefonnummern

In der folgenden Tabelle sind die Telefonnummernformate aufgefihrt, die die Mitel Web Extension in
anklickbare Telefonverbindungen konvertieren kann.

Format Beispiele

Telefonnummer im INTERNATIONALEN Format

+1213 373 4253

Telefonnummer im E.164-Format

Telefonnummer im RFC3966-Format

+12133734253
tel:+12133734253;ext=123

US-Telefonnummer im NATIONAL-Format

(213) 373-4253

sttzt.

NOTE: Telefonnummern im NATIONAL-Format werden fiir andere Lander auf3er der USA nicht unter-

Installieren der Mitel Web Extension

Fihren Sie die folgenden Schritte aus, um die Mitel Web Extension in Ihrem Browser zu installieren.
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Google Chrome
1. Offnen Sie den Chrome-Browser auf lhrem Gerat und klicken Sie im Chrome Web Store auf Mitel

Web Extension.
2. Klicken Sie auf Zu Chrome hinzufiigen.

Fas chrome web store * Sign in

Home > Extensions > Mitel Web Extension

m Mitel Web Extension

Offered by: Mitel

0 | Productivity & 4users

Overview Reviews Related

3. Ein Eingabeaufforderungsbildschirm mit den Informationen, auf die die Extension zugreifen kann,
wird angezeigt. Klicken Sie auf Extension hinzufiigen, um die Extension zu installieren. Durch
Klicken auf Abbrechen wird die Installation abgebrochen.

1 m Add "Mitel Web Extension"?

It can:

Read and change all your data on the websites you visit

<

Microsoft Edge

1. Offnen Sie den Edge-Browser auf Inrem Geréat. Klicken Sie auf Mehr Symbol ( = - - ) > Extensionen.
Die Seite Extensionen wird geoffnet.

2. Aktivieren Sie die Option Extensionen aus anderen Stores zulassen unten links auf der Seite
Extensionen.



https://chrome.google.com/webstore/detail/mitel-web-extension/njodpoefbejllnijefababpjlkhologo
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= Extensions

B4 Get extensions for
Microsoft Edge

Developer mode

Allow extensions from
other stores. Learn more

3. Es wird eine Eingabeaufforderung angezeigt, in der Microsoft Sie darauf hinweist, dass die Exten-
sionen im Chrome Web Store oder in anderen Drittanbieter-Stores nicht tGberprift wurden. Klicken Sie
auf Zulassen, um mit der Installation der Extension fortzufahren. Durch Klicken auf Abbrechen wird
der Installationsvorgang abgebrochen.

Allow extensions from other stores
Microsoft does not verify extensions installed from third-

party stores. To get extensions verified by Microsoft, go
to the Microsoft Edge add-ons website.

4. Navigieren Sie im Chrome Web Store zur Mitel Web Extension und klicken Sie auf Zu Chrome
hinzufiigen.



https://chrome.google.com/webstore/detail/mitel-web-extension/njodpoefbejllnijefababpjlkhologo
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#~ chrome web store & Ssignin

Home > Extensions > Mitel Web Extension

m Mitel Web Extension

Offered by: Mitel

0 | Productivity ] o 4users

Overview Reviews Related

5. Ein Eingabeaufforderungsbildschirm mit den Informationen, auf die die Extension zugreifen kann,

wird angezeigt. Klicken Sie auf Extension hinzufiigen, um die Extension zu installieren. Durch
Klicken auf Abbrechen wird die Installation abgebrochen.

m Add "Mitel Web Extension" to Microsoft
| Edge?

The extension can:

» Read and change all your data on the websites you visit

Uberpri]fen Sie nach der Installation der Mitel Web Extension, ob die Extension installiert und aktiviert ist,

indem Sie in Ihrem Browser zur Seite Extensionen navigieren, die Mitel Web Extension suchen und
Uberprifen, ob das Umschalten aktiviert ist.

Mitel Web Extension
JU

o) Dials phone numbers on web pages using an
installed Mitel softphone

Details Remove c @
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M
NOTE: Klicken Sie in Google Chrome auf das » Symbol, um die Extension ( Mitel ) neben der

M
Adressleiste anzuheften. Standardmagig wird die Extension ( Mitel | ) in Microsoft Edge neben der
Adressleiste angezeigt.

Verwenden der Mitel Web Extension

In diesem Abschnitt wird beschrieben, wie Sie die Mitel Web Extension verwenden, wenn MiCollab als
Standardanruf-App auf Ihrem Gerat festgelegt ist. Mit denselben Schritten kdnnen Sie die Extension mit
anderen unterstitzten Mitel-Anruf-Apps verwenden.
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NOTE: Wenn Sie sich bereits vor der Installation der Extension bei Microsoft Teams oder der Microsoft

Outlook-Webanwendung angemeldet haben, miissen Sie diese Webanwendungen neu laden, damit die
Extension aktiv wird.

1. Klicken Sie nach der Installation der Mitel Web Extension auf die Telefonnummer, unter der Sie einen
Anruf von der Microsoft Teams- oder Microsoft Outlook-Webanwendung tatigen méchten.

John Smith
8/11

|+1 404 383 3639 |

§ 8 & O (S

Message John Smith B

-
@ John Smith  chat 3more~ + oo

8/11 4:39 PM
Test

Today

9:44 AM

+1404 383 3639 o

Type a new message

Ae ! ¢ @ @B B E B Q9 W . B
4

2. Je nach verwendetem Browser wird eine Eingabeaufforderung angezeigt.

- Google Chrome

Wenn Sie im Google Chrome-Browser auf die Telefonnummer klicken, die Sie wahlen moéchten,
wird eine Eingabeaufforderung zum Tatigen eines Anrufs unter angezeigt, in der MiCollab ange-
zeigt wird, das als Standardanruf-App auf Ihrem Gerat festgelegt ist. Klicken Sie auf MiCollab.
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Make a call from

[4 MiCollab

To send a number from here to your Android phone,

turn on sync for both devices in settings.

- Microsoft Edge
Wenn Sie im Microsoft Edge-Browser auf die Telefonnummer klicken, die Sie wahlen moéchten,
Diese Seite versucht MiCollab zu 6ffnen. Eingabeaufforderung wird angezeigt. Klicken Sie im Eing-
abeaufforderungsdialogfeld auf Offnen, um den Anruf mit MiCollab fortzusetzen.

This site is trying to open MiCollab.
https.//teams.microsoft.com wants to open this application.

|
|
I Always allow teams.microsoft.com to open links of this type in the associated app

|

NOTE: Um sicherzustellen, dass Microsoft Teams jederzeit Telefonverbindungen von MiCollab aus
offnen kdnnen, ohne zur Bestatigung aufzufordern, aktivieren Sie das Kontrollkastchen
Teams.microsoft.com immer erlauben, Links dieses Typs in der zugehorigen App zu 6ffnen.
3. Dadurch wird die MiCollab-Anwendung gestartet und die von Ihnen gewahlte Telefonnummer wird im
Suchfeld angezeigt.

MiCollab - O X

Make call

@ +14043833639

@‘5‘ {:p SoftPhone
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4. Klicken Sie unter Anruf tatigen auf die Telefonnummer, um den Anruf zu tatigen. Es wird ein Rufbe-
reitschaftsfenster mit dem Namen des Anrufers, der Telefonnummer und dem Bild (falls vorhanden)
angezeigt.

Deinstallation der Mitel Web Extension

Fihren Sie die folgenden Schritte aus, um die Mitel Web Extension von lhrem Browser zu deinstallieren.

Google Chrome

1. Offnen Sie den Chrome-Browser auf Ihrem Gerat. Klicken Sie auf das Symbol Mehr ( * ) > Weitere
Tools > Extensionen. Die Seite Extensionen wird gedffnet.

2. Suchen Sie Mitel Web Extension und klicken Sie auf die damit verbundene Option Entfernen.

Mitel Web Extension

-4
' o) Dials phone numbers on web pages using an

installed Mitel softphone

Details Remove & @

3. Ein Eingabeaufforderungsbildschirm wird anéezeigt. Aktivieren Sie das Kontrollkdstchen Miss-
brauch melden, wenn Sie einen Missbrauch melden méochten.

4. Klicken Sie auf Entfernen. Die Mitel Web Extension wird von lhrem Browser deinstalliert. Durch
Klicken auf Abbrechen wird die Deinstallation abgebrochen.

m Remove "Mitel Web Extension"?

Remove Cancel

Microsoft Edge

1. Offnen Sie den Edge-Browser auf Inrem Gerét. Klicken Sie auf Mehr Symbol (- -- ) > Extensionen.
Die Seite Extensionen wird geoffnet.

2. Suchen Sie Mitel Web Extension und klicken Sie auf die damit verbundene Option Entfernen.
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m Mitel Web Extension 1.0.0 0
B Dk phone numbers on web pages using an installed Mitel softphone

ID bimdpemimbheoaphnemlaaeijigpokhg  Inspect views Background page

Details JRemove] Reload

3. Ein Eingabeaufforderungsbildschirm wird angezeigt. Aktivieren Sie das Kontrollkastchen Miss-
brauch melden, wenn Sie einen Missbrauch melden mochten.

4. Klicken Sie auf Entfernen. Die Mitel Web Extension wird von lhrem Browser deinstalliert. Durch
Klicken auf Abbrechen wird die Deinstallation abgebrochen.

Rk

oy
] Remove "Mitel Web Extension”

from Microsoft Ecdge?

Remove Cancel

Fehlerbehebung bei Problemen mit Mitel Web Extension

Dieser Abschnitt enthalt Anweisungen zum Beheben haufiger Leistungsprobleme mit Mitel Web Exten-
sion.

» Browserspezifische Probleme

» Extensions-Probleme

Browserspezifische Probleme
Google Chrome

M
1. Wenn das Mitel Web Extension-Symbol ( Mitel ) nicht neben der Adressleiste des Browsers ange-
zeigt wird, navigieren Sie zur Verwaltungsseite fur Chrome-Extensionen unter chrome://extensions
und stellen Sie sicher, dass sie aktiviert ist.

Mitel Web Extension

-4
' o) Dials phone numbers on web pages using an

installed Mitel softphone

Details Remove ] @

10
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2. Browseranforderungen: Mitel Web Extension unterstiitzt die neueste Release-Version von Google
Chrome. Stellen Sie sicher, dass auf lhrem Gerat das neueste Chrome-Update installiert ist. Hilfe zum
Aktualisieren von Google Chrome finden Sie unter Aktualisieren von Google Chrome.

3. Caches und Cookies in Chrome loschen - Ein Aufbau von Caches und Cookies kann Probleme mit
der Extension verursachen. Stellen Sie sicher, dass Sie die Caches und Cookies in lhrem Browser
[6schen.

4. Google Chrome-Einstellungen auf Standard zurticksetzen - Wenn das Problem durch die oben
genannten Schritte nicht behoben werden kann, setzen Sie Chrome auf die werkseitigen Stan-
dardeinstellungen zurlck.

Microsoft Edge

M
1. Wenn das Mitel Web Extension-Symbol ( Mitel ) nicht neben der Adressleiste des Browsers ange-
zeigt wird, navigieren Sie zur Verwaltungsseite flir Edge-Extensionen unter edge://extensions/ und
stellen Sie sicher, dass sie aktiviert ist.

w Mitel Web Extension 1.0.0 0
B Dizls phone numbers on web pages using an installed Mitel softphone
ID bimdpcmimbhesophnemlaaeijigpokhg Inspect views Background page
Details  Remove Reload

2. Browseranforderungen: Mitel Web Extension unterstutzt die neueste Release-Version von Microsoft
Edge. Stellen Sie sicher, dass Sie das neueste Update von Edge auf lhrem Gerat installiert haben.
Hilfe zum Aktualisieren von Microsoft Edge finden Sie unter Wie aktualisiere ich den Edge-Browser?

3. Caches und Cookies in Edge Ioschen - Ein Aufbau von Caches und Cookies kann Probleme mit der
Extension verursachen. Stellen Sie sicher, dass Sie die Caches und Cookies in lhrem Browser
I6schen.

4. Edge-Einstellungen auf Standard zurlicksetzen - Wenn das Problem durch die oben genannten
Schritte nicht behoben wird, setzen Sie Edge auf die Standardeinstellungen zurtick, indem Sie die
folgenden Anweisungen befolgen:

a. Offnen Sie Microsoft Edge auf Inrem Gerat und klicken Sie auf die drei Punkte in der oberen
rechten Ecke.

b. Klicken Sie im sich 6ffnenden Dropdown-Menu auf Einstellungen.

c. Klicken Sie im linken Navigationsbereich auf die Registerkarte Einstellungen zuriicksetzen.

d. Klicken Sie auf der angezeigten Seite auf Einstellungen auf ihre Standardwerte zuriick-
setzen.

Extensions-Probleme

Wenn das Problem durch die oben genannten Verfahren zur Fehlerbehebung im Browser nicht behoben
werden kann, navigieren Sie zur Verwaltungsseite fur Chrome-Extensionen unter chrome://extensions.
Stellen Sie sicher, dass der Entwicklermodus aktiviert ist. Suchen Sie Mitel Web Extension und klicken
Sie auf die Schaltflache Fehler, um das Fehlerprotokoll zu 6ffnen.

11


https://support.google.com/chrome/answer/95414?co=GENIE.Platform%3DDesktop&hl=en
https://support.google.com/accounts/answer/32050?co=GENIE.Platform%3DDesktop&hl=en
https://support.google.com/chrome/answer/3296214?hl=en
https://answers.microsoft.com/en-us/edge/forum/edge_other-edge_win10/how-do-i-update-edge-browser/72aa3a08-8b52-472b-bcc0-22c3b2a59698
https://support.microsoft.com/en-us/help/10607/microsoft-edge-view-delete-browser-history
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' ' Mitel Web Extension 1.0.2

o) Dials phone numbers on web pages using an
installed Mitel sofiphone

ID: bfpekpapdealkgbdiicpclpkooeaikib
Inspect views background page

Details Remove

Errors c o

Machen Sie einen Screenshot der gesamten Seite.

€&  Errors

Clear all

o Uncaught TypeError: Cannot read property ‘charAt' of undefined ~ [ ]

Context

https://voko.atlassian.net/browse/MTI-38

Stack Trace

script: ipt.js:112 (

function)

164 | * Released under the MIT license

106 | /*!

109 | * @author Feross Aboukhadijeh <https://feross.org>

11e * @license MIT
111 n

112 | e.exports=function(e){return null!=e&inull!=e.constructor&d"function“==typeof e.constructor.i: +

4

*/1function(o){if(void @===(i="function"==typeof(r=0)2r.call(t,n,t,e):r)||{e.exports=i),l0,e

187 * petermine if an object is a suffer

-
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Navigieren Sie im Chrome Web Store zur Seite Mitel Web Extension Overview.

£~ chrome web store

Q Sign in

Home > Extensions > Mitel Web Extension

Dﬂ Mitel Web Extension

Offered by: Mitel

o] | Productivity | 2 4users

Overview

Reviews Related
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https://chrome.google.com/webstore/detail/mitel-web-extension/njodpoefbejllnijefababpjlkhologo
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Klicken Sie im Abschnitt Zusatzliche Informationen auf Entwickler kontaktieren.

Additional Information

@ Report abuse

Version
1.0.1

Updated
August 17, 2020

Size
574KiB

Language
English

Developer

| Contact the developer
Privacy Policy
960 Stewart Dr
Sunnyvale, CA 94085
USA

Eine Standard-E-Mail-Anwendung wird geéffnet und zeigt die Mitel-Support-E-Mail-Adresse an. Fliigen
Sie den Screenshot hinzu und senden Sie die E-Mail an unser Support-Team.

From:

To: google.partner@mitel.com;

Subject

13
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